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ASCENDER - Position Management: Setup
and Processing for New Users

This guide provides new users with the necessary steps to begin using the Position Management
application.

This guide assumes you are familiar with the basic features of the ASCENDER Business system and
have reviewed the ASCENDER Business Overview guide.

Set up Position Management Current Year Payroll Tables

1. Review and/or update job codes.

Personnel > Tables > Job/Contract > Job Codes

Before beginning this process, consider the existing job codes in the current year payroll. It is
important that there are no changes made to the existing job codes that are already assigned
to employees in the current year; however, you can add new job codes to the table.

J0B CODES COMTRACT CLASS CONTRACT TERM CONTRACT YEAR EXTRACT ID TERMINATION REASOMN

Delete  Job Code fob Deseription EEOC Code Accout Code Inc
(o000 ] [sUBSTITUTE TEACHER | ~] |4
(o020 ] [HOURLY HOLIDAY PAY ] [185ervice workers W] [ 1 ] 3-0-] §
[ o100 ] [SUPERINTENDENT ] [o1 mar_ %] [ ] i
(o101 ] [INTERIM SURERINTEMDENT ] [0LOfhcisl sdmin mgr ] [Ro-x K ]
(o112 ] [assisTan ] [o1of ]
(o115 ] [eusm ] [oLoe | i
(0116 | [cummicuLumM DIRECTOR ] [010Offciel sdmin mar W] [ ] i
(0120 ] [ADMIMISTRATIVE ASST ] [e x 0K o] g
(0121 ] [DIRECTOR SPECIAL PROGRAME] MOS0 ) I
(0122 ] [DIRECTOR FOODSE ] ] 1
[(o135 ] [mReCTOR. sPECIAL EDUCATICH] ] 1
((o1ze | [racmaToR/DAER | ~] [ ] 1
[(o1z3 ] [ADMINCOMEDE ATT ][ ~] ] 1
(o120 | [ocsmacFTcHR ] [07 Dther classrm teach W] [MOOOOEO0000ENNEE0R] ]
(0133 ] [suPeRwiscRwoceoucamon] [ w ] [-- - --- ] 1
»
23 [ | [Last Azl

For LEAs that accrue, each job code can only tie to one accrual code. You may need to perform
maintenance to ensure a good starting point. For example, if a job code is set up for a teacher
and you have employees with 187 work days and employees with 197 work days tied to that job
code, a new job code should be added so that an accrual code exists for both sets of
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employees. Do not make changes to existing job codes that are tied to employees, changes can

be made when creating positions.

If the LEA expenses workers' compensation, it is important to set up those codes on the job
code table. If workers' compensation codes are not established, expensing will not occur for
that position. For each position, the workers' compensation code is retrieved from the job code.

2. Update salary tables.

When using Position Management, all employees must be tied to one of the following salary

tables:

Personnel > Tables > Salaries > Local Annual - Contracted employees

LOCAL ANMUAL  HOURLYDAILY  EXTRADUTY  FUNDTO GRANT  STATEMIMIMUM  SUBSTITUTE  MIDPOINT
Z'h':.E'n:e[ﬁ] | Retrieve | |
Pay Stepe | AL W
Delete Pary Grade Pay Stepy Max Diays Employed Local Sched Anrual femt
if [ 2o [ 23 1 s 1B i || 2,033.02]
(& J[_o ] [ i ] [_sss7155)
[ acr ]| o1 1 |- R | | 0,495.00]
[ e ] 02 | | | [ soseses
[ 2 | [ o ] | 168§ | [ 4ma71es]
=1 C=1 | i | | (=779
[ em ]| a0 I = 1. ] [ 7076218
Ce JC = ) Cw ] | ) (esomong)
[ MNTE |l 1 1 000 1 1 | [ 4s.20000]
e J(Cw ] Cw ] | ) [(eesmng)
e )= ] [ B ) =z
= J = ] | i | (===
[ we ]| 1 | ] ] [__sess0.00]
(v J [ | | Ji 4 ] [_35045000)
e J[_ s | | || J [_st2s000)
‘ 5 (3] [tas s

Personnel > Tables > Salaries > Hourly/Daily - Contracted and Non-contracted employees
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LOCAL AMNUAL  HOURLY/DALY  EXTRADUTY  FUND TOGRANT  STATEMINIMUM  SUBSTITUTE  MIDPOINT

Pay Grade| Al W | Retrisws | | Print

Pay Stape |0 W

Deelete Pary Grade Pay Sten Hrs Per Day Rate Type Local Sched Pay Type Est Owtm Hrs Armourrt:

== ]l 11 2 | — -
T T O TR e A | | [ ][ ao [ 45437
CE=JC= = ™ | ) | 2 ——
[ 2 | 01 ] [ o ] = ~] an] [ 39,547
= JC e ][ om J[%% | ] [ > 0g) [_zsise)
[ E [ 03 ] [ oo ) ’. [ ] [ ~]1 on] | 26955
[ | [ e | [ oo ]| P I 2 | an) | 5957
[z J[ e J[ e ] ™% | ] ~] | o] [ 236734)
C= )= JC e ] % | ) | ¥ o) =)
[z J[ e J[ em ] ™% | ] ~] | a0) [ 31z378]
= JC = J e ] ™ | ) | 2 | R
[ 12 ][ m ][ e ] i [~ ao] | 5.234]
= JC = JCm ]| ™= [ ) | > | 0] [ ]
[ = ][ JL_em o ] | ~] | ) [ 34m34]
[ ] J o )| % | L ¥~ o] [ 20¢as
‘ 10 (] [Lam add

Personnel > Tables > Salaries > Midpoint - Contracted and Non-contracted employees

If your LEA has employees who are not tied to a salary table, it may be helpful to create a
midpoint table. For instance, if all LEA employees are assigned to a pay scale except for
cafeteria workers and bus drivers, whose salaries vary, it can be difficult to maintain a
consistent table setup. In this case, you can set up a midpoint table with different pay grades
for each job and then assign employees to that table.

TIP: Consider grouping “like” jobs when setting up the midpoint table.

2026/03/21 08:42 3 ASCENDER - Position Management: Setup and Processing for New Users


https://help.ascendertx.com/test/business/lib/exe/detail.php/general/setup_processing_newusers_hourly_daily_table.jpg?id=academy%3Abusiness_positionmanagement_setupandprocessingfornewusers
https://help.ascendertx.com/test/business/doku.php/personnel/tables/salaries/midpoint

Business

LOCAL ANNUAL ~ HOURLY/DALY — EXTRADUTY  FUNDTOGRANT — STATEMINIMUM  SUBSTITUTE  MIDPOINT
Pay Type: [BL_w |
Delete  Pay Grade Eay Type Mlinimueny Maciemum Micipoink Hours Dock Rate Type
[ oFc | [FHourlyemployee W ] [ 7.250] | EEED E N 0.00] | [H - Hourly W |
[ mz ] [tContractsdemployes %] [ 163480] [ Z20000) [ an74s] | oo0] (O-Deily ]
[ ] [LCantracted smglayes w# ] [ 1e3.200] [ 2n000) [ 190.745] [ 0.00) [D-Daily ]
1P IHourly emplayes W] | asoo] [ azan) | 1z000] [ .00] [H-Hourly %
[ 210 ] [Conwactedemployes ] [ 2zes20] [ 31ete0) [ 271400] | oo0] [D-Deiy W)
( e6z0) [ alelan] [ z7lamd] | 0.00] [D-Daily ]
[ ws1o] [ ag70) | 12530] [ .00 [H-Hourly w
[ 211 ] [LcConwactsdemglayes %] [ z47020) | 3a4640] [ zose3n] | 0o0) [0-Deily ]
[ 3FG | [FHouwlyemployee W] [ 11510] [ gomn] [ 1=730] [ 8.00] [H-Hourly % ]
[ #13 ) [LConwactsdemplayes w] [ 2em2s0] [ 3rseso] [ 322.4s0] | 0.00] [D-Daily w)
[ 4rc ] [3Hourlysmglayee ] [ 12730 | 7750] [ 15.240] | 2.00] [H-Hourly %]
[ eanon] [ annmsn) | as020] | ooo0| [D-Daily
([ zemomo] [ 4o1asn) [ 1] [ 0.00) [D-Daily W)
( ze20e0) [ anLesd) [ 5020 [ 0.00) [D-Daily ~)
zezoo0] [ aoreso] [ as.020] | 0.00] [D-Daily
O Click +Add and enter the following information:
o Pay Grade
o Pay Type
o Minimum - The lowest daily pay rate an employee would receive in this pay grade/pay
type.
o Maximum - The highest daily pay rate an employee would receive in this pay grade/pay
type.

O Click Save. The Midpoint is automatically calculated.

3. Update school calendar.

Personnel > Tables > Workday Calendars > School Calendar

All positions must be tied to a school calendar code. Existing school calendar codes can be
used. If there are positions that do not follow the existing calendar codes, you can add new
calendar codes. Calendar codes can be alpha or numeric.

It is important that the begin and end dates match the calendar. For example, when entering
the begin and end dates, many LEAs use 7/1-6/30 for 12-month employees. If 7/1 and/or 6/30
fall on a weekend and your calendar has a begin date of 7/2, then the employee's begin date
should be 7/2.
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SCHOOL CALENDAR ~ COPYSCHOOL CALENDAR  DELETE SCHOOL CALENDAR

a c T |Loumay | T = m
o 5 MT [zsomMa0 | 261 _
0 E NC (127 LBRARY AIDES ] 197

0 5 NC [127 LERaRY 2IDES | 197

o) E FC (220 2dmin |

o] 5 PC [220 Admin ] 220

] E PR (207 _start ] 207

0 5 PR [z07 start ] 207

O E TC [127 Staf ] 187

O 5 TC [187 stafe ] 187

o E TR [TRS WORKDAYS ] 187

0 B TR [TRS Cal | 261

] 5 TR [TRS WORKDAYS ] 187

0 4 R [Trs | 253

”
Add

4. Set up next school year pay dates.

Payroll > Tables > Pay Dates

Pay dates can be created for the next school year. The current year dates are used at this time,
but the pay dates for the next year must be set up prior to rolling positions to the next year
Position Management.
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Start Pay Date [ Retrieve ] [ P
Delete  Details SshoolYear  BavDate Bepin Datg EndDpte  IBSMooth TWC Quarter Print Alternate Sddress
o o] 2024 | [ ca-23-2024 || [ 0e02-2024 | [ 08-31-2024 || [[ 0= | O
' o 2024 [ 07252024 ) [07-01-3024 ) [07-31-2024 | [ 07 ) =) O
i) o 2024 | 06-24-2024 | | D601-2024 | | 06302024 | [ 06 | E] 0O
o 2024 05242024 ] [o5012024]) (05212024 ) [05] [2] O
o [o) 2024  [o0425-2024 | [04-01-2024 ] [ 04302024 ] [ 04 ] O
o 2024 [03-25-2024 | [03-01-2024 ] [0331-2024 ] [ 03 ] m O
ir o 2024 | oz-23-2024 | [ 02-01-2024 | | 02292024 | [ 02 | O
o) 2024 [o0125-2024 ) [o0101-2024 ) [o2312024 ] [ o1 | II] O
I (8] 2023 [ a2z202023 ) [1201-2023 ) [a23s2023 ] [ a2 ] (4] O
o 2023 (24203 (Qrorzes ) (msezas] (]  [&]) O
i o 2023 | 10-25-2073 | | 10-00-2003 | | 10-31-2023 | | 10 | [3 ]
[a] 2023 [oo252023 ) [os012022 ) [ooa02023 | [ om | O
i o 2023 | 08.25-2023 | [ 07-08-2023 | | o80a2023 | | o8 | O
o 023 (o750 | [eewzons ) (ororzzm ) (o7 ) [ O
I (0] 023 | 06-23-2023 | | 05-06-2003 | | 06082023 | [ 06 | m i
1 E] i2 I Last | e
Selected Pay Date
Adjustmant Nor DatePayRun  Interface  User D
No Fiows

5. Clear next year payroll tables and copy all tables from current to next year.

Log on to the current year pay frequency.

CAUTION: Before moving forward, keep in mind that this step clears all manual
changes that were made to next year salary tables.

Perform the following two processes:

Payroll > Next Year > Copy CYR Tables to NYR > Clear Next Year Tables

This tab is used to clear:
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o All next year tables for all pay frequencies regardless of the pay frequency to which
you are logged on.

o Only EQY accrual data.

o Only next year payroll budget data.

Individual frequencies cannot be selected for deletion.

Note: EOY accrual reversals must be created and interfaced to Finance before clearing next
year tables or EQY accrual data only.

CLEAR MEXT YEAR TABLES COPY CURRENT YEAR TABLES
() Clear EOY Accrual Data Only [ Clear NY Payredl Budsget Only
Mo Fows D Accrual Calendar I
D Extra Duty Pay
[ Hourly  Daily Salary
D Job Code
D Local Annual Salary
D Midpaoint Salary
D School Calendar
D State Minamum Salary
- D Substitute Salary
= D ‘Werkers' Compensalion Rates
D Employes Bank Record
' D Employes Deductions
D Employee Extra Duty
[0 Emeloyes Fay
D Employee Pay Distribution
D EOY Accrual Calendar
D EOY Accrual Data
D ECOY Accrual Fund Decrement
D WY Payroll Budget
Clear next year tables:
Field Description
Clear EOY Accrual Data |Select to clear the EQY accrual data records only. All other next
Only year data is left intact.
Clear NY Payroll Budget |Select to clear the next year payroll budget records only. All other
Only next year data is left intact.

Note: If an option is not selected, all displayed next year tables for all pay frequencies
(regardless of the pay frequency to which you are logged on) are cleared when you click
Execute.
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All available next year payroll tables are displayed on the left side of the page. Select the tables
to clear. Use the arrow buttons to move the selected tables from the left side to the right side of
the page.

O Click Execute. A message is displayed indicating that the next year records have been
cleared. Click OK.

Payroll > Next Year > Copy CYR Tables to NYR > Copy Current Year Tables

This tab is used to copy all tables or selected tables as next year records for the
corresponding next year frequency (e.g., CYR = 6, NYR = F; CYR =5, NYR = E; and CYR = 4,
NYR = D). The tables are copied from all current year frequencies to all next year frequencies
(except the School Calendar table). The School Calendar table header is only copied for the
frequency to which you are logged on. To copy the school calendar for another frequency, log
on to the other frequency and copy the School Calendar table. The calendar itself is not
copied, only the calendar code and calendar description. Type the year in the Start Year
field and the beginning month in the Start Month field to begin the process of building the
next year calendar.

CLEAR MEXT YEAR TABLES COPY CURRENT YEAR TABLES *

Accrual Calendar

Extra Duty Pay

Hourly / Dadly Salary

Job Code

Midpoint Salary

Schipo] Calendar

Siate Minimum Salary

(
(
[
(
Local Annuel Salary (
[
(
(
(

Substitute Salary

LeereE A8 )

Wiorkers' Compensation Rates [

Copy current year tables:

All available current year tables are displayed on the left side of the page. Select the tables to
copy. Select the corresponding check boxes to select a table. At least one table option must be
selected.

o Select  next to the table(s) to copy.
o Select (J again to clear the selected check box.

O Click ¥ if you do not want to copy the entire table, but want to include specific data from a
table.
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Notes:

o Only the selected tables are processed.

o If the tables are copied multiple times and the record in the current year does not
exist in the next year, the new record is inserted in the next year.

o |If the tables are copied multiple times and a description is changed in the next year
but not in the current year, the description is replaced by the description in the
current year table.

O Click Select All Tables to select all current year tables to copy to the next year.

O Click Execute. A separate preview report is displayed for each selected table.

O Click Process on each report page to copy the table. Or, click Cancel not to copy the table. A
message is displayed indicating that the tables were successfully copied. Click OK.

6. Copy current year staff to next year payroll.

Log on to the current year pay frequency.

Payroll > Next Year > Copy CYR Staff to NYR

[ e J[ e [ ome ]

Parameters
Pay Status:
@) Active () Inactive () Beth Primary Campus: [ AlL ~|  Payoff Date: [:]5
Pay Campus: [All “] Frequency: 16 MONTHLY CYR V]
|Pay Type: | E Exclude Substitute v Contract Begin Date: | ~|  Salary Concept: (an ~|
Job Code: TAL ~] Cantract End Date: [ ¥| ExractiD: ( ~|
2 [
Acarual Code: | Al v) Contract Months: ]: EmployeeNbe [ 3
R .
Prior Yr Emp Date: | 00-00-0000
Options

[]include Employees with Termination Date
Dlnactivate Records when Creating NY Tables

Mext Year's Funding Code

Mumber of Remaining Deductions D

D Preview changes

Complete the following:
U In the Pay Type field, select E - Exclude Substitute.

O Under Options:
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o Select Include Employees with Termination Date.
o In the Next Year’s Funding Code, type the fiscal year that exists in Budget.

O Click Execute. If the process is successful, a preview report is displayed. Review the
employee list to verify that the correct data was copied to the next year records. Also, review
the total employee count at the end of the report.

O Click Process to accept the changes and continue. A message is displayed indicating that
the process was completed successfully. In addition, a list of the database record tables that

were copied is displayed. Click OK.

O Click Cancel to return to the Copy CYR Staff to NYR page without making the changes.

Set up District Administration Options

1. Update Position Management options.

District Administration > Options > Position Management

This page is used to create and maintain Position Management options including the types of
calculations that should be used in Position Management and the specified default values to
be used for certain types of Position Management transactions. These options are not
typically changed throughout the school year.

District Options
Use PMIS Curment Year:
Unernplayment Eligible: Hext Year: 200
FICA f Medicare Eligible - Subject to medicane v Minémum Foundation Year
Use Forecast Conversion Tables Default Position Record Status: |-'.,' - Waeant] just position info, ready to Sl emp) vJ

Ermployes Must Be Assigned 3 Position Priod to Creating Payroll Record:
Allew CYR Position Description Changes (Admin only)

Allgw Forecast Position Description Changes:

DHHEHIHH

Display Options to ignane Pot of Day and Pet of Year for Pesition Records:

Payment Options

Round Salary to Nearest Whole Dollar

During CIC Calculation. Pay One-Time Supplement
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O Verify that the following fields are completed and accurate:

o Current Year

o Next Year

o Minimum Foundation Year - Type the four-digit current or next school year in the YYYY
format to allow the system to select the corresponding tables to calculate the state
minimum salary amount. If this year matches the current year value, the current
Personnel state minimum table is used. If this year matches the next year value, the next
year Personnel state minimum table is used.

2. Set up category codes.

District Administration > Tables > PMIS > Category

This step is optional.

This page is used to create and maintain a list of LEA-defined category codes to be used for
Position Management. The category codes can be assigned to positions to allow for easier
inquiries. There are no calculations done based on the category. The codes are strictly for
Position Management and do not impact any other system. Categories can be used in User
Created Reports; however, they are not available in any other report parameters.

CATEGORY
Starting Categary I:-'_*-':l:[:] [ Ietrieve ] [ Print
Delete  Category Code Category Description
[poo1 ] [ACCELERATED INSTRUCTION ]
[cooz ] [BILUNGUAL EDUCATION ]
[o003 ] [STUDENT ASSESSMENT ]
[0004 |  [SPECIAL ED AIDE ]

3. Update first pay date codes.

Use the following pages to establish the current and next year first pay dates and codes.

District Administration > Tables > PMIS > First Pay Date > Current Year
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This tab is used to create and maintain a list of codes associated with current year pay dates
to be used for Position Management. The codes are used:

o To establish an association between a table ID and a starting pay date.

o To establish a start date for a new teacher so that a new teacher can be paid over 13
months.

o To determine the first pay date of the new school year when calculating the amounts
already paid to an employee.

o To calculate the amount to be paid to an employee during the change-in-compensation
processing.

o To update the payroll data with the data in the forecast records, and to move the
forecast data into the current position records.

In this example, the first pay date codes begin with J, A, or S to represent the first pay date

month (July, August, or September). The subsequent two characters represent the calendar
code. Codes can be a maximum of three characters and any letters should be uppercase.

CURRENT YEAR HEXT YEAR

Starting Pey Date Lude[:

Delete  First Pay Date Code  First Pay Date Description

¥S CN DIRECTOR

]
|

Complete the Current Year and Next Year tabs. The Current Year tab represents the first pay
dates for the current school year, and the Next Year tab represents the first pay dates for the
next school year.

District Administration > Tables > PMIS > First Pay Date > Next Year
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[ ww |

CURRENT YEAR MHEXT YEAR

Starting Pay Date Cuu:D | Ritrise | [ Print -]
Delete  First Pay Date Code  First Pay Date Description
f [a17 [210 DAYS 15T OF AUG START ]
o= [ )
fh AEC [EARLY CHECK-13 ]
(ari (197 N DIRECTOR |
8 (& [ )
n (o1 [ J
m [ao2 | |
[ao3 [ ]
m [#0s (195 Daws ]
= ( )
o (4G [ ]
@ [ )
i [118 [TEACHERS JULY START ]
& [ )
8 @ r )
[t [220 Davs ]
8 [ [ )
(e | )

4. Set up action reason codes.

District Administration > Tables > PMIS > Action Reason

This page is used to create and maintain a list of action reason codes to be used for Position
Management.

An action code is required when a change is made to a position record that creates a

historical record. Action Codes for termination transactions can be cross-referenced with the
Termination Reason Codes on the Personnel > Tables > Job / Contract > Termination Reason
tab. Be sure to consider LEA-required data and statistics when creating action reason codes.
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e
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o
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[ o1 ] [EMPLOYEE WACATED [SV5] g |l
[ 02 ] [cHencEINPOSTIONINFO(SYS) |
[ 03 ] [EMPLOYEEMOVED INTDFOS [SYS) il
[ 04 ] [soFenD-oFY |
[ 05 ] [ASOFFRST-OF-YEAR [5VS) |
() ([ ) |
(7] [Forem |
[ o8 ] [RemaveSupplement |
[08 ] [NewHir= ] [ o4
[ 10 ] [AddedSupplement ||
(7] == )
[ 12 ] [Demation ||

J
J
J
]
J
E
J
]
J
J
J
]

Sawe
ACTIOM REASOM
Starting Action Reasaﬁ:] [ Retrizve ] [ Print
Delete  Action Reason Action Reason Description Termination Reason Termination Deseription

Left the employment market for parsonal reazons

5. Set up inactivate reason codes.

District Administration > Tables > PMIS > Inactivate Reason

This page is used to create and maintain a list of inactive reason codes to be used for
Position Management. When a position is changed to inactive status, you are prompted to
enter a reason, which is saved in the historical records.
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Save

INACTIVATE REASON

Starting Inactivate Esas{:-"u{:] [

Retrigve ] [ Print

Delete Inactivate Reason Inactivate Reason Description

[ AT ]  [Asrtion

[e:et'a billet

[ Student Mumbers

6. Transfer positions from one first pay date code to another.

District Administration > Tables > PMIS > First Pay Date Forecast Conversion

This page is used to change a start date code to another for forecast conversion, and should
only be used if you need to transfer all positions from one First Pay Date Code to a
different First Pay Date Code. All positions tied to the From Start Code will be added to
the To Start Code. For example, the program could be used to update the first pay date
code when a new hire employee on a 13-month pay date cycle needs to convert to a regular

12-month pay date cycle.

FIRST PAY DATE FORECAST CONVERSION

Starting Pay Date Cc\de::] l Retrieve ] l Print
Delete From Start Code From Start Code Description To Start Code To Start Code Description
] iTC 187 Days (25 pmts) 3 187 Days (24 pmts)
Ico ] July Payroll ENC H 197 Days

7. Update forecast conversion data.
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6 Prior to completing this step, the calendars and pay dates must exist in the next
year payroll files.

District Administration > Tables > PMIS > Forecast Conversion

This page is used to create forecast data for the next year's records. This table maintains the
data conversion information by the First Pay Date Code for the Calendar Code, Begin
Date, End Date, Payoff Date, Max Days, Number Of Days Off and Actual Payments.
These fields should be updated with the dates to be used for the next school year. From this
data, the appropriate calendar data is located and the following calculation is performed: The
Local Begin Date is subtracted from the Local End Date, and then the Number of Days
Off is subtracted resulting in the number of Actual Days. This data is moved to the next
year's records at the time the budget is created for the next year.

FORECAST CONVERSION
J J =
First Py Calendar Extra Duty [ Lacal Local Last Wurnber 04 Actual Actusl
Dulete Dats Code Coge Code Date Descraption Bagin Date End Date Pay Date Max Days Days Off Days Payments
B E ) CrTr | e | I | I | — )
E I CE ]i | ) 192023 | [oes 203 |1 173) | 00] | 173 17
[sin J1 [ 15 ]§  TEACHER + 10 DAYS 25-2023 | [oa-25-2003 |1 | 190] o0] [ 190] [ 12]
(sre )i [ ]: )3 182083 | [cezsen Ji 180] 0g] | 180] | 12
B FE_Ji i 20w 20 | e | 0 | m—— | —s B|
E ) B 0 | e [ 0 | B — | a—
B B C EE0 | o | O ) T ) | —
E ) E ) oo 5) @oaen 1t () | ) ) ( 5|
E i i C s %) Eaes i C = 59) =) | )
= FE_J: s 5 ) wses )1 (39 (o9 (9 ( )
o B )i )t wsows 0 | G2 R B T | S B|
[aoa )i (o2 Ji | ) ERRCEETTERI| 203) o0 | 203] | 12)
(o2 Jp (o2 i | )4 | [erasom |3 [ 03] | 09] | 23] | ]|
B B C )@z ) (9 =9
Er )i E_Ji i 1erenomecron 5) F=as i o) | e | — B|
B E )i s ws ) @mea i (w0 (__ =3
( I Jr 2 i ) [ i | o] 09] | o | ]|
[ i | J3 [ Ji N J1 [ 9] | 0q] | o ( 1)
( Ji [ | O | ] i 9 [ o8] | ) 33
( It [ I+ [t ] It | o] | 0g] | o) | 1)
( Ji | Jg [ i ) [ 8 9 [ 0] [ o) [ 12
[ | F | Ji [ )i J | 9] | on] | o) [ 12
( 133 i [ s J I 8 9 [ 0] | 7 [ 1)
( i+ Jt [z ]t ] [ [ER| 9] 0] o) 12)
[ E | J: [ s ) [ [E| o) [ on] o [ 13
( 1 | Jt M5 ]t 1N JE | 9] | on] [ o) 12

For each pay date code, complete the fields on the page. The next year begin and end dates
must match the new calendars in the next year payroll files, and the payoff dates must exist in
the pay dates table for each first pay date code.
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This process updates the table and replaces the mass updating process that is done in the next
year payroll.

The Days Off field is used to reduce the days worked without tying back to unavailable days on
a calendar. For example, a district police officer may work every day (or have the potential to
work every day) but may have a certain number of days off per year that can be taken at any
time.

Import Position and Distribution Data

1. Import checklists.
After the setup steps are completed, use the following checklists to import position and
distribution data.
Import Position Data to PMIS Checklist (prints separately)

Import Distribution Data to PMIS Checklist (prints separately)

2. Verify imported data.

Use the following reports to verify that the records were correctly imported to the current
year Position Management.

O Generate the Position Management > Reports > PMIS Reports > HRS8050 - Position Listing
by Campus report to verify that all positions exist with accurate information.

The report provides a list of all positions within a campus. The report is sorted by campus
number and includes each job position along with a position number, billet number,
description, employee number, employee name, percentage of day worked, and pay
frequency.
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k d W

Dt Pl Pomstion Listng by Campuns Progeam: HRSS050

by Dt -] Fage: 1ol w

dLagai

Pronsticn Wi Buallet hir Poaition Description Fing (B Wl [Erglerpns Hama Pt Wkl

PEHT Q00m CRIMINAL JUSTICE ] Q000Es 10000 %
LT SO0 Solball Masd L1 00 G004
PSHI408 Q0003 SECONDARY SPECIAL 5 20 = 00000 %
S8 T Q004 Specsl B4 ] a0 000 %
HEeCH WU Chewr Sponsor 5 2001 Do0%
PEH1408 200 SECORDARY ART 5 20115 100000 %
PEH1401 Q0002 BECONDARY EMGLIEEH 5 01 plo=livk
SEMY W ol Ghued L] [=r=rhly Q00 %
SoREE ] Baseball Head 5 =0 x =1k
BEHOC Q000 Feariball Offes Cognd 5 OO0 U
PEH4OT Q0001 SECONDARY FOREIDH ] Q000 3 00 D0
GEaCh SO00E  Chesr Sponsor ] f00gs T =1
PEATIES 2000 DHE Reapienat £ O0DE islie

O Generate the Position Management > Reports > PMIS Reports > HRS8054 - PMIS/Payroll
Discrepancy Report to verify that there are no discrepancies.

The report allows you to print a list of all positions that do not have payroll records or a list of
payroll records that do not have position management records.

4 ¥
Dhles Fus PMIS T Payroll Dhscrepancy Repor Progran: HIRSEA
sty Dt i Page 1 ol B
ddy L] Corgeanson
Pom Bdlet
Freg TP Fomition Nix [ Demcriplion Emp Mbr Fmpskryen Mame Mravign
5 P PEMI454 0003 TEACHERS AIDE DOES Dz ot Barwn the sama job codes or extra duty
eoded i CYR Payral
] g S5a0 Q0003 Assocates Degies 000183 Dicerg reai Baree the 8ama b COSeS O eniin duly
codes = TVR Payrod
- P PSMTE05 L0003 SECONDARY READING D0 u Dicmg not barew the same ob codes or axtrs dety
codes n CYR Payrod
5 P PSEVIS4 0004 TEACHERS AIDE DODENE Dz st Barws th sar ok codes o extin duly
ended = CYR Payrel
& P POIMMM 0001 CRIMINAL JUSTICE [k ) Does nead Parwe e same b Codes O exirp duty
codes & CVR Payrod
5 & G5HEH 0001 Schtal Head bo03ES Dicasn nict Barew tha sama ok codes or exbre dusy
rodes m CYR Payrol
5 P PEEI451 0001 EECRETARY FEIME CLERK DOOZH0 Dicsta oot Birws the saew ol codies or axtin duty

O Generate the Position Management > Reports > PMIS Reports > HRS8053 - Midpoint Salaries
Exception Report if your LEA uses midpoint.

This report provides a list of positions that have salary rates that are not within the minimum
and maximum salary ranges.

A "I
LEE Mchpoand Salanes Enoapion Heport Prosgran: HITEBIND
ity Diai: ED Paga: 1ol 1
[Poaition - Ballet Hos Emplryen Hama Emp Ntr  Freg  HoulpTieily Rete e/ Siallary Exncpton Mossagn

PSAT03 - 00001 OGEE 5 243 TEY F30.000 Drady Rate > Maxirwuss Salary
PSAY105 - DO001 OO0ESS 5 405 DEg 400 950 Daily Rste > Madeaus Salany
PSEVIT - DOO0 Q0051 5 354,100 354006 Dady Rate > Mao=us Salary
PSE1IS = 00007 QO0Z24 5 V18400 116.000 Daly Rate > Maosuss Salany
PSH 1807 « D000 Q0038 5 354,100 354096 Dty Raste > Maorswuss Salary
Enel of Flnpon

O For additional information, use the Position Management > Inquiry > PMIS Position Inquiry
page to perform a position inquiry.
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’ Retrieve ] ’ Print ]
Pasition Deccrition: [ CHILDCARE PROVIDER ]  Position Nbr: [PSD1802 |3
Details Position Description Position Mumber Billet Mumber Position Type Status Freg Employes Nbr Employee Hame Campus
jo) CHILDCARE PROVIDER PSD1802 00003 Position Artive E 000434 773
(9] CHILDCARE PROVIDER FSD1802 00001 Position Active E 000713 773
[e) CHILDCARE PROVIDER PsD1802 00002 Position Active E 000230 773
Occupant
Employee Nbr: 000434 Employes Name:
Primary Job: ¥ Increase Eligible: M
Pay Grade: 2PG Hourly Emp State Step:  Begin Date: 07-28-20 © End Date: 06-2B-20  Payoff Date: 07-30-20

Days Off: 0O NbrDays Employed: 217 Hourly/Daily Rate: 10510 Salary: 13,24530 Remaining Payments: 24

Position
Status: A Frequency: E SchoolYear 20
Category: Supplement Attached: M
Job Code: 1802 1stPay Date Code: APR Calendar Code: DC Primary Campus: 773 Dept
Hours Per Day: 8.0 Percent Day Employed: 100 Percent Year Employed: 100 State Minimum Days: O
Pay Concept:  Midpoint EEQC: 16 Workers' Comp: B TRS Member Pos: 03 Max Days: 217 Max Payments: 24 Owertime Eligible: ¥
Supervisor: Position:  Billet  Employes Mumber™ame:  not occupied

Ignore Pct Day Employed for Salary Cales: M lgnore Pet Year Employed for Salary Cales: N

Perform Position Management Maintenance

Log on to the next year.

1. Delete next year PMIS.

Position Management > Utilities > Mass Delete Forecast Positions
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T T
Select Positions only (F). Supplements only {S) or blank for ALL: D
Selact Fosition Statuses or blank for ALL: [ ] :]
Select Position School Years or blank for ALL: [ ] :]
Select First Pay Diate Codes or blank for ALL: [ ] :]
Select Extra Duty Codes or blank fior ALL: [ ] :]

Select Positions or blank for ALL:
{Includes ALL billets for selected positions [ ] :]
Blank for ALL mot processed when Positions/Billets selected)

Select Positions/Billets or blank for ALL: ( ] :]

Selact Supplement Positions or blank for ALL:

{Includes ALL billets for selected supplement positions [ ] :]
Blank for ALL mot processed when Supplements/Billets selected)

Selact Supplement Positions/Billets or blank for ALL: [ ] :]

Year: M

O Leave all fields blank and click Execute. A list of processing reports is displayed.

[ Process h{ﬂ ]
Processing Reports
Selact Report Mame
Mass Delete Forecast Positions Process Error Listing
hass Delete Forecast Positions by Employee Mame
Mass Delete Forecast Positions by Campus
Mass Delete Forecast Positions by Position/Billet
[ Generate Reports ] [ Select AlL ] [ Umnizelect All ]

O Select the reports to generate, and print or save the reports.

O Click Process to delete the forecast records. You are prompted to create a backup.

2. Copy current year positions to the next year.

Position Management > Utilities > Create Forecast Positions
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Include Proposed Positions:

Move Forecast Conversion Actual Payments to Position Max Payments:
{Also includes remaining payments if Position occupied)

Move Forecast Conversion Actual Payments to Supplement Max Payments:
Reset Supplement Amounts based on Extra Duty Code Table Default Amount]
Move Forecast Conversion Max Days to Supplement Max Days:

Move Supplement Max Days to Supplement Extra Days (occupied only]:

Move Supplement Max Payments to Supplement Remaining Payments:

PREEEE 8

If an LEA has the Percent of Year field set to less than 100% of the stipend

amount on the Position Management > Maintenance > PMIS Supplement Modify >

Position Record tab, they should consider whether or not to select the Reset

Supplement Amounts based on Extra Duty Code Table Default Amount
é ., field.

If the Reset Supplement Amounts based on Extra Duty Code Table Default
Amount field is selected, the amount on the supplement position record is reset to
match the amount on the extra duty table.

O Select all fields and click Execute. A list of processing reports is displayed.

[ Process h ncel l

Processing Reports

Select Report Mame

Create Forecast Positions Process Ermor Listing
Create Forecast Positions by Position/Billet

[ Generate Reports l [ Select All l [ Unselect AlL

O Select the reports to generate and print or save the reports. Verify any errors and make
corrections as needed.

O Click Process. You are prompted to create a backup.

3. Update the fiscal year for distributions.
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Prior to completing this step, verify that the new year budget is initialized in ASCENDER.
Position Management > Utilities > Update Fiscal Year by Fund

O Select the fund/years to be incremented. This process increments the position distribution
fiscal year by 1.

[ Retrieve l [ Execute h

UPDATE FISCAL YEAR BY FUND

Increment Fiscal Year by 1

Increment Fund/Year

(O Click Execute.

4. Generate the Position Listing by Campus Report.

Position Management > Reports > PMIS Reports > HRS8050 - Position Listing by Campus

Generate the Position Listing by Campus Report from next year Position Management to
determine the following:

o If any employees need to be moved to a different position.
o If you have vacant positions you need to update with employee information.
o If you have any supplemental positions that need to be updated for stipends.
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M4 » M

Date Run: Position Listing by Campus Program: HRSB0S50

Cnity Dist: ISD Page:1of 11

Campus

Position Billit Hbr Position Description Freq Emp Hbe Employee Hame Pct Worked

EXTRADUTY 00002  FROZEN CARRYQVER 3 000026 0.00 %
PTEACHER 00205  ENGLISH g 000028 100.00 %
ATHLETICS 00015  BASKETBALL ASST 3 000027 0.00 %
ATHLETICS 00098  TRACKASST 3 000027 0.00 %
ATHLETICS 00113  VOLLEYBALL ASST 3 000027 0.00 %
EXTRADUTY 00005  FROZEN CARRYQVER g 000034 0.00%
EXTRADUTY 00006  FROZEN CARRYOVER 3 000041 I 0.00%
PTEACHER 00606  SOCIAL STUDIES 6 000041 100.00 %
PCAMPUS 00114  AIDE 3 000048 100.00 %

5. (If necessary) Transfer positions from one first pay date code to another.

District Administration > Tables > PMIS > First Pay Date Forecast Conversion

This page is used to change a start date code to another for forecast conversion, and should
only be used if you need to transfer all positions from one First Pay Date Code to a
different First Pay Date Code. All positions tied to the From Start Code will be added to
the To Start Code. For example, the program could be used to update the first pay date
code when a new hire employee on a 13-month pay date cycle needs to convert to a regular
12-month pay date cycle.

Save

FIRST PAY DATE FORECAST CONVERSION

Starting Pay Date Code::] [ Retrieve ] [ Print
Delete From Start Code From Start Code Description To Start Code To Start Code Description
ATC i 187 Days (25 pmts) H 187 Days (24 pmt=)
ICO H July Payroll SHC H 197 Days

Add

6. (If necessary) Update regular and supplemental positions.

Note: If your LEA comes across a situation where teachers are not being captured in the
ASCENDER Student system for grade reporting or scheduling, contact your regional ESC
consultant for guidance.

2026/03/21 08:42 23 ASCENDER - Position Management: Setup and Processing for New Users


https://help.ascendertx.com/test/business/lib/exe/detail.php/general/setup_processing_newusers_hrs8050positionlistingbycampusb.jpg?id=academy%3Abusiness_positionmanagement_setupandprocessingfornewusers
https://help.ascendertx.com/districtadmin/doku.php/tables/pmis/firstpaydateforecastconversion
https://help.ascendertx.com/test/business/lib/exe/detail.php/general/setup_processing_newusers_districtadmin_firstpaydateconversion.jpg?id=academy%3Abusiness_positionmanagement_setupandprocessingfornewusers

Business

Position Management > Maintenance > PMIS Position Modify or PMIS Supplement Modify

i .---.--.:,.-5 Pegitan Daserigtion| TEACHER 1t [ i
Dwtails Bitlat SShYR  Descripton T Frag Emp N First Naiss M N Laat Mari Gen
o] 00 024 [TEACHER | F
CL o2 [ | E
c DaL0 0 1 & FLOF | 3 001179 WANDA MARIE WILLIAMS
0 o103 | 2024 st ] A £ 00185  WENDY CHARLES VILSOM
0 010 2 [ ] F 000791 MELISSA HMEW EMPLOYEE
O i [ HALF T ] A F  oDiioe HITHE L o
POSIMION RECORD DISTRBUTION DATE BUDGET
Cocupant
Erngd it 5 vt Madine HARL
ry Job :--. ase Eugble D'_-AI' e D
e, [Tt v see: (G5 scbote [ s S (G Begin O (G52055 ) e | vt e
ot [ 0] o iaps Employedt 15300 Heurtetiaty Rate: [ 255 158] aa ining Paymerns: [ 13) =)
Postion
rept Changes Sramus. [ .
o Code: [1000 - TEACHER J; Depe [j
or At EEOC  Work i ligitde: []
[ ]
cates: [] lge

If working on the Distribution tab, you must select an account code from the
autosuggest drop down in the Account Code field versus typing in the full
account code in order to validate against the grant code table.

If necessary, use one of the following options to vacate an employee from a position:

O Option 1: It is best practice to use the Position Management > Utilities > Vacate Employee
from Forecast Positions page to vacate a position.

Typically, when an employee decides to leave the LEA at the end of the year, the employee is
paid off in payroll at the end of their contract; therefore, no additional action is necessary for
the current year. However, in the forecast records, the employee must be removed from all
existing positions.
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Save jﬁ
VACATE EMPLOYEE FROM FORECAST POSITIONS
e 5 !
Wacats | Dotads Accept Chis  Podition Typs  Podition Mumber Prriition Dird rigtion Balst  SchYR Jobr T Sawtus
o L PEBAADLT LEAD WELLMESSPE FACILITATOR. | 00001 3035 AZ17-LEADWELLNESS FACLITATOR A
o & s SEATY TRAVEL 00000 2026 A
Croupart Indorraton
Job-Code: [A217 - LEAD WELLNESS FACILITATOR ] Primary lobc [f]  Percent Day Employed Percent Year Employest
Pay Concent padpaint Pary Gradse: [l-_u, Contracted emp  State Siep E] Begin Date: [(07.15-2024 | End Date [u-; 132025 | Payolf Date ['ug?f;;;_--,
o Dy 210.0| Dawe O ) Mo Doy Employed: 21000 Howrs Per Doy, T FosaryTiaily feate: B84 688 | Actusl Salary: @0 784 00 Remaining Paymant:: 12
Prmary Campu: (303 - 903 School Dept: (] Colendar Cete- (T8 | TRS Member Pert: ([ - Professional stat | trer Eligitda: 7]
(Distribation bvioimaton
Ativity Code Aroourt Code Grant Coda Warkers' Comp Expense 373 Ergiayer Contribafion Parcent Amaurt Dp At
- (e i3enso0mss1io0 A | = 70000 5654880
- [101-35-6115.00-938- 569000 | A | [Somea) 20
Totalz: 100000 BOTE400

o Retrieve the employee's position record.
o Select the Vacate check box for each position.
o Click Save.

O Option 2: Use the Position Management > Maintenance > PMIS Forecast Change page (only
available in the next year payroll) to change an employee from one position to another. A list of

the employee's existing positions is displayed with a section to either enter a new position or
vacate a position.

Current Forecast Positions,
Duotails Prosarinn Summber Perumssn Description Biles Sl YR Job Code: eatus
o PTEACHER SOCIAL STUDES o06a7 2024 1000 - TEACHER A

Primary Job Percent Doy Emgloyed EI Percent Year Employed £ sruilate
L P Pay Step 1 Schedule Dg Saate Step E] Begin Date: [08-03-2023 | End Date [05-23-2024 | Payolf Date
VE D ON '.':.- Days Emgloved: 183 00 Houwrs Per Day HourlwDaiy R 204 011 | Acual Salary: 53804 D0 Remars

0 Rema
Primary Campus: [001 - D01 School J: Dert D'.‘:..m:u- Code: 10 TRS Member Pos: (17 - Teacher, borarian incr Pay Step £
Desete Artivity Code Astount Code Grart Code Wiorkers' Comp Expense 373 Employer Contribution Percent Arnteant Dup Acct
(= |z'_- Baze Salary v] |".3~:- 11-6119.00-001-41 1000 A 5380400
Teorsis: 1001000 53.804.00
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7. Generate the PMIS/Payroll Discrepancy Re

port.

Position Management > Reports > PMIS Reports > HRS8054 - PMIS/Payroll Discrepancy Report

Generate the PMIS/Payroll Discrepancy report to determine if there are any active employees

not assigned to a forecast position. Below

are some examples of the PMIS/Payroll Discrepancy

report:
Dot P PMIS. ] Paryeoll Discropancy Report Program: HRSEGL
Criby Dt 0 Prage: Tl 9
b Ll Companson
ot
Freg T Provatin M el Dscrption g M Ernploryn Mo Mrvenm
E P PSAINR 00007 ADMBESTRATIVE [ L] Does: roct harve the same jobrcodes or exira duty
codes in TR Paryecl
E P PSAIND 00007 DR OF TECHMOLDGY o0oess Cots nat harve the same job codes o exir duty
oodes in TR Payecl
E P PSATIOE 00007 TRANSPORTATION COORD [ F ] Do rict b S s jobs codes or endra duty
codes i OV Payscl
E P PSAING 00001 BURSINESS MANAGER DOCEES Doss not have e same joboodes o exirs duty
codes in CYR Payscl
E P PSATIE 0000 DIRECTOR ATHLETICS [ ie o] Do rict havs S savmas jobs codes o endra duty
oodes i CYR Payecl
E P PSINT CO001 PEIMS COORDINATOR ooctag Coes rect harve tha same jobcodes o extra ety
codes in OV Payecl
E P PSRN0 00007 FACILITIES CeRECTOR 000872 Does nct have the same job oodes or exdma duty
Date Run: PMIS | Payroll Discrepancy Report Program: HRS8054
Cnty Dist: 5D Page: 1 of 1
Employes Level Comparison
Pos Billat
Frog TYP Position Nbe Hbr Dwacription Emp Mbr Employes Mama Mosango
F P PCAMPUS DO300 PRINCIPAL 000012  ADKINS, ALEXANDER LYNN Inactive in CYR Payroll
& 001140  BUSMGR, IMA Active emp not assigned 1o Forecast Position
6 000&31  POER. PACER P Active emp not assigned 1o Forecast Posithon
] 001058 WHARTONM, TYLAR DEMAA  Active emp not assigned to Forecast Position
6 001120 WILLLAMS, WENDI IRENE Active emp not assigned 1o Forecas! Position
[ 001134 WYNN, WYOMING Active emp not assagned 1o Forecast Posdtion
] 001135 YARBROUGH, TACHARY KAY Active emp nol assigned to Forecast Position
8 001138 YOUMNG, ZEB MARTIN Actrve emp nol assigned Lo Forecast Position
L] DO1138 ZAPATA. ZOMA ASHLYMN Actrve emp nol assigned 1o Forecas! Position
Total Number of Employees 9
End of Report

. Generate a user-created report.

Position Management > Reports > User Created Reports > CYR/NYR Positions

Generate a PMIS user-created report to ve
applicable positions. It is possible that the
year.

rify that the Increase Eligible field is selected for
field is not selected for new LEA employees from last

O It is recommended to verify the Nbr Remain Payments field prior to calculating salaries.

O Select the following fields on the user-created report:
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[ Save ] [ Create Report ] [ Delete ] [ Reset ] Year; C e

PMIS Position/Distribution Export File Auta Select Options

D PMIS Pogition Control D PMIS Position Distribution

DPMIS Pasition Control

[ JCYRMYR Flag [ contract Beg Date [Jpay Empld Pet [JExtra Duty Code

ition Mbr [ Contract End Date Pt of Year [ 5upplement Type

it D Payoff Date DPE‘- Concept D Supplement Max Amt
D"GD'DQ-’SC"H : [:|Base Suppl On Dly Rate
DA:! Hrly Dly Rate D Supplement Pay 1 Time

[]5alary Amount [Jpate Supplement 1 Time

D Occ Fay Type

D Suppl Recaloulate

D Ign Pct Day For Sal Calcs
[Jtan Pet ¥r For Sal Cales
[ Mew Employee

|:]I'K.-r. on School Year I Mbr Remain Payments I 3 Gﬁ::ost Change Midpoint Base
DF.':—:,encT |LJlab Catzgary DMB:\ Payments D Date Create/Update DPe'cmt of Midpaint
DG.'_: Employee Mbr D Supplement Attached DU-.-'.'.’ Elig Fig B Date Fill Duﬁe/‘"alc-,-me'.t Elig Flag
[ ]Primary Job ek Code [J5tate Minimum Days [JFill Pesition Reasen [JFica Elig

I’.:'ease Elig D 1st Pay Date Code DSaus' Position Mbr G Date Criteria D._-_lS Status Code

|J O Pay Grade D Calendar Cade DSavs* Billet Mbr D Drate Authorization DBch_: et Amount
DCL: Fay Step D Campus I DSupo.eme nt Extra Days D Date Authorization End DBng et Salary Override
[JOec Fay Schedule e [J5upet to Pos Mer [Joate Entry [O#cwaliBudget Ind
DSta:e Step Dl—rs Per Day DSJp-o.tc Pos Billet DDEte Inactive DPE‘- Type

DPMIS Position Distribution

[JCYRMNYR Flag [Jiek Code [JFunction [JEd Span [(JExpense 373
Dl"csi: on Mbr D;‘\ccsu nt Type D Object D Project Detail DC.:.ﬁ'.‘iI:- At Flag
DE Llet Nbr Df‘av Activity D Sub Object Dh‘.ccun: Ameount
Dr‘csizjn Type D'v‘.'c'ké's Comp D Organization D;*u'_:cun: Percent
[ vistribution Segquence OFte D [ Fiscal Year [ TRs Grant Code
DFreq_encT DFunc D Program Intent D Extra Duty Code

DEmplwae Demo

DMJG[;—N:.-“;— D-Ge'.era:ic'.

O Click Create Report. The report is displayed. Use the sort/filter functionality to group the
applicable data.

Note: The number of remaining payments reflected on the report is displayed on the Job
Info tab as the number of annual payments and the number of remaining payments for the
employee for any P position type. If the LEA uses S acct types or business allowances for
extra duties, S position types on this report should reflect the correct number of remaining
payments. Prior to continuing, make the necessary position corrections.

9. Update position records.

Position Management > Maintenance > PMIS Position Modify > Position Record

If necessary, update the Increase Eligible field to identify the employees who are eligible to
receive a salary increase for the new school year when running simulations. Only the employees
with this field selected will receive a salary increase.
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O Clear the Increase Eligible field for new employees who are not entitled to a salary
increase. Remember that the next year Position Management pay step reflects the same
current year Position Management pay step, and the step is increased in the salary simulations
if the Increase Eligible field is selected.
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POSTICN RECDRD DESTRIBUTION — DWTE BUDGET

Orxupant

— . .

Primary Jokc [] increase Elgile: [] New Employee:

Dy 0t [ 2] M D Emplvc 14300 Dy 7436.00 Pemaring Ponares: (T3] Bichute a
Poastian
b Coce: [1000 - TEACHER s ¢ D [ZJ! @ Primadery Campuan: [0 - 001 ey ]i Dest D
[ Ji e [ Ji t
¥ o Dl-_.- Y for . |:|

O If necessary, update the New Employee field to identify new employees on forecast position
records. If selected, the salary simulations will budget the employer contribution for new
employees even though they do not have current year payroll records.

Notes:
This field is not displayed on supplemental position records.

If the position is changed to any status other than Active, the field is disabled.

O Clear this field If an employee is no longer new to the LEA.

Position Management > Maintenance > PMIS Position Modify > Budget

If there are retirees who work in the LEA, confirm that the TRS Status field is set to 5 - Retired.
If the TRS status is incorrect, there is a possibility that the status will be incorrect (TRS-eligible)
when the employee is moved to the current year payroll.
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POSITION RECORD  DISTRIBUTION  DATE  BUDGET h

Vacancy/Budget Information
Pay Grade: |30 |: Pay StepfState Step: D Mon-Contracted emp  FTE:
Midpoint Base: Plus Percent of Midpoint
Unemployment Eligible: FICA/Medicare Eligible: [M - subject to medicare v | TRS Status: [‘5‘ - Retired v]
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